EDITORIAL

Welcome to the latest issue of Full Circle

Once again, we bring you: Python, Stable Diffusion, Latex, Micro This Micro That, and Inkscape.

The next issue, and the last of 2023, is number 200. Two hundred issues of this monthly madness. Who’d have thought? I certainly didn’t. For our second centenary I’d like to ask you, dear reader, to submit a few words on how you found FCM. When? Where? Why? It’d be nice to have a page or two dedicated to how you found FCM.

This issue is brought to you by the letters A, S, U and S. My Entroware desktop machines was getting a bit old, and lacked any GPU, so playing anything was a challenge. This one is a gaming PC so I can once again enjoy Euro Truck Simulator and several others. Fear not! A review is forthcoming.

Don’t forget: we have a Table of Contents which lists every article from every issue of FCM. Huge thanks to Paul Romano for maintaining: https://goo.gl/tpOKqm and, if you’re looking for some help, advice, or just a chinwag: remember that we have a Telegram group: https://t.me/joinchat/24ec1oMFO1ZjZDc0. I hope to see you there. Come and say hello.

All the best for 2023!
Ronnie
ronnie@fullcirclemagazine.org

FCM PATREON: https://www.patreon.com/fullcirclemagazine

Find Full Circle on:
facebook.com/fullcirclemagazine
twitter.com/#!/fullcirclemag
https://mastodon.social/@fullcirclemagazine

Weekly News:
https://fullcirclemagazine.org/podcasts/index.xml
http://www.stitcher.com/s?fid=85347&refid=stpr
http://tunein.com/radio/Full-Circle-Weekly-News-p855064/
**Release of qBittorrent 4.6 with I2P Support:** 23/10/2023

The release of the torrent client qBittorrent 4.6, written using the Qt toolkit, has been published. Among the features of qBittorrent: integrated search engine, the ability to subscribe to RSS, support for many BEP extensions, remote control via a web-interface, sequential download mode, advanced settings for torrents, peers and trackers, bandwidth scheduler and IP filter, torrenting interface, support for UPnP and NATMP. The project code is written in C++ and is distributed under the GPLv2+ license.

https://www.qbittorrent.org/news.php

**Alternative Installer Agama 5:** 24/10/2023

The developers of the openSUSE project published a new release of the installer, Agama (formerly D-Installer), developed to replace the classical installer of the SUSE and openSUSE. It has a notable separation of the user interface from the internal components of YaST. Agama provides the ability to use various frontends, for example, a frontend to control the installation through a web-interface. YaST libraries continue to be used to install packages, equipment checks, disk breakdowns and other functions required for installation, abstracting access to libraries through the unified D-Bus interface.

For testing, live-builds with a new installer (x86_64, ARM64) were formed, supporting the installation of the openSUSE Tumbleweed builds, as well as the openSUSE Leap Micro, SUSE ALP and openSUSE Leap 16, built on the basis of isolated containers.

https://github.com/openSUSE/agama/releases/tag/v5

**Ubuntu LTS Release Support Time Increased to 10 Years:** 24/10/2023

Canonical announced a 10-year deadline for the development of updates for Ubuntu's LTS releases, as well as for the basic packages with the Linux kernel originally supplied in LTS. Thus, the LTS release of Ubuntu 22.04 and the Linux 5.15 kernel used in it will be supported until April 2032, and updates for the next LTS release of Ubuntu 24.04 will be formed until 2034. Previously, decisions on similar extensions of the support period from 8 to 10 years were taken separately for the releases of Ubuntu 14.04, 16.04, 18.04 and 20.04.

Half of the 10-year support is provided under the ESM (Extended Security Maintenance) program, which covers updates with the elimination of vulnerabilities for the kernel and the most important system packages. Access to ESM updates is provided to users of a paid subscription to technical support services. Free ESM-updates for 5 years can be obtained upon registration subject to personal use. Official members of the Ubuntu Community can get an ESM update for free. For ordinary users, access to updates is only available for five years from the release.

The support period for Debian GNU/Linux, taking into account the extended LTS support program, is 5 years (plus selectively two more years as part of the "Ext LTS" initiative). Fedora Linux is supported for 13 months and openSUSE is 18 months.

https://canonical.com/blog/linux-kernel-lts

**Release nginx 1.25.3, NJS 0.8.2 and NGINX Unit 1.31.1:** 25/10/2023

A release of the main branch of nginx 1.25.3 has been formed, where the development of new
opportunities continues. In parallel, to the supported stable branch of 1.24.x, only changes are made related to the elimination of serious errors and vulnerabilities. In the future, a stable 1.26 branch will be formed based on the main 1.25.x branch. The project code is written in the C language and distributed under the BSD license.

http://nginx.org/#2023-10-24

**Release of TrueNAS Scale 23.10:**
25/10/2023

I Xsystems has published the TrueNAS SCALE 23.10 distribution, which uses the Linux kernel and Debian package base. (previously manufactured products of this company, including TrueOS, PC-BSD, TrueNAS and FreeNAS, based on FreeBSD). Like TrueNAS CORE (FreeNAS), TrueNAS SCALE can be downloaded and used for free. The size iso image of 1.5 GB. The original code for TrueNAS SCALE assembly scripts, web-interfaces and layers are published on GitHub.

TrueNAS CORE products based on FreeBSD and TrueNAS SCALE based on Linux develop in parallel and complement each other, using a common code base for the toolkit and a typical web interface. The provision of an additional edition based on the Linux kernel is explained by the desire to implement some ideas that are unattainable when using FreeBSD. It is noteworthy that this is not the first such initiative - in 2009, FreeNAS has already separated OpenMediaVault, which was transferred to the Linux kernel and Debian package base.

https://www.truenas.com/blog/truenas-scale-23-10-is-released/

**MySQL DBMS Available 8.2.0:**
26/10/2023

Oracle has formed a new branch of MySQL 8.2 and published corrective updates to MySQL 8.0.35 and 5.7.44. MySQL Community Server 8.2.0 versions are prepared for all major Linux, FreeBSD, macOS and Windows distributions.

MySQL 8.2.0 is the second edition, formed within the new model of release generation, providing for the presence of two types of MySQL branches - "Innovation" and "LTS." The Innovation branches, which include MySQL 8.1 and 8.2, are recommended for those who want to access new functionality earlier. Updates of the branch is published every 3 months and is supported only until the next major release is published. LTS branches will be produced every two years and will be maintained in the normal mode for 5 years, in addition, it will be possible to receive another 3 years of extended support. In 2024, the LTS release of MySQL 8.4 is expected, after which a new Innovation-branch 9.0 will be formed

https://dev.mysql.com/downloads/mysql/

**The First Cinnamon Porting Results on Wayland:**
26/10/2023

The developers of the Linux Mint project announced the adaptation of the Cinnamon custom shell based on the Wayland protocol. Experimental support for Wayland will be available in the release of Cinnamon 6.0 scheduled for November, and an optional session with Cinnamon based on Wayland will be offered for testing in the release of Linux Mint 21.3, which is expected in December.

The porting is still in the early stage, and many of the features available when Cinnamon is launched in an environment based on X.org are not yet available or incorrectly working in Wayland. At the same time, when you launch in a Wayland environment, the control of windows and virtual desktops already works, and most of the applications and components, including the file manager and the panel, are also running.

They plan to bring Cinnamon on Wayland to full readiness before the release of Linux Mint 23, which will be out in 2026. After that, the developers will consider the possibility of switching to Wayland by default. It is expected that two years will be enough to eliminate all the problems they currently have.

https://blog.linuxmint.com/?p=4591
NEWS

Project Genode
Published OS Sculpt
23.10:
27/10/2023

A new release of the Sculpt 23.10 project is presented, within the Genode OS Framework, developing a general-purpose operating system that can be used by ordinary users to perform everyday tasks. The original code of the project is distributed under the AGPLv3 license. A LiveUSB-image, measuring 28 MB, is available for download. Operation on systems with Intel processors and graphics subsystem with VT-d and VT-x extensions included, as well as on ARM systems with VMM extensions.


KDE Implements Support for Wayland Extensions for Colour Management:
28/10/2023

In the code, on which the release of KDE Plasma 6 is formed, support for the Wayland protocol extensions responsible for colour management has been added to the KWin composite server. In the KDE Plasma 6 session, the Wayland-based one, the ability to separate colour control for each screen is implemented. Users can now assign their ICC profiles for each screen, and the apps using Wayland will provide correct colour reproduction. In addition, the colours selected using the "Color Picker" application are now converted into sRGB colour space and processed taking into account their colour profiles.


Canoeboot (GNUboot?):
28/10/2023

Leah Rowe, the main developer and founder of the Libreboot distribution, presented the first edition of the Canoeboot project, developed in parallel with Libreboot and positioned as a completely free build, which meets the requirements of the SPO Foundation for completely free distributions. The project was previously published under the name of "unofficial GNU Boot," but after the receipt of a claim from the creators of GNU Boot was initially renamed nonGeNUine Boot, and now in Canoeboot 20231026, is based on the recent version of Libreboot 20231021, where components and changes that do not meet the criteria of the SPR Fund have been removed.

The need to create a separate build of Libreboot is explained by the fact that the requirements for free distributions formed by the SPO Foundation do not allow the supply of binary firmware and any binary components of drivers.

https://libreboot.org/news/canoeboot.html

The Dagor Game Engine:
29/10/2023

Gaijin Entertainment has opened the source code of the Dagor Engine, which has been developing for more than 20 years and has been used to create games such as 3D shooters Enlisted, Crossout and CRSED: F.O.A.D., adventure action movie Blades of Time, Apache: Air Assault and Battle Warload Thunder. The engine supports Windows, Linux, macOS, Nintendo Switch, PlayStation 3-5, Xbox One,
NEWS

Xbox Series X/S, Android, tvOS and iOS. The graphic API supports Vulkan, DX12, DX11 and Metal.

Among the capabilities of the engine we can note: physically correct rendering (PBR), built-in simulator of physics processes, collisions, destruction and physics of vehicles, the ability to connect external physical engines, dynamically destroyed environments, support for NVIDIA Waveworks, a wide range of graphic effects and lighting management methods, dynamic and soft shadows, global lighting, support HDR, voluminous sound, synthesizing, SLsimulator of plants, support for skeletal, procedural and hybrid animation, subsystem for creating multiplayer networking and online games, level and resources editors.

The engine code is written in C/C++ and opened under the BSD-3 license. Judging by the notes in the repository, the code is imported from the dagor4 repository (Dagor Engine 4), but the separate files mention version 6.5 (Dagor Engine 4 released in 2016, Dagor Engine 5 in 2018, and Dagor Engine 6 in 2020). In addition to the engine in the repository, examples of the use of the engine, skyshares and global lighting, as well as auxiliary utilities, such as resource viewer, font generator, dryers compiler, utilities for format conversion, Dargbox, script editor and stage builders were published.

https://github.com/GaijinEntertainment/DagorEngine

RELEASE OF UBUNTU SWAY REMIX 23.10:
30/10/2023

Ubuntu Sway Remix 23.10, providing a pre-configured and ready-to-use desktop based on the mosaic composite manager Sway, is out. The distribution is an unofficial edition of Ubuntu 23.10, created with an eye on both experienced GNU/Linux users and those who want to try the mosaic window manager. To download, builds for the amd64 and arm64 (Raspberry Pi) architectures were prepared.

The distribution environment is built on Sway - a composite manager using the Wayland protocol and fully compatible with the mosaic window manager i3, as well as the Waybar panel, PCManFM-GTK3 file manager and utilities from the NWG-Shell project. Those are, the Azote desktop wallpaper manager, full-screen nwg-drawer application menu, the GTK theme setting manager, the morsator and nwg-lawn fonts and the Autotiling script, which automatically composes the open applications windows in the same way as dynamic mosaic window managers.

The distribution includes programs with both graphical interfaces such as Firefox, Qutebrowser, Audacious, Transmission, Libreoffice, Pluma and MATE Calc, and console applications and utilities such as Musikcube music player, MPV video player, IMV image viewing utility, PDF app and Neimr.

Another feature of the distribution is the complete refusal to use the Snap package manager, all programs are supplied in the form of ordinary deb packages, including the Firefox web browser, which comes from the official PPA repository, Mozilla Team. The distribution installer is based on the Calamares framework.

https://github.com/Ubuntu-Sway/Ubuntu-Sway-Remix

GHOSTBSD 23.10.1:
30/10/2023

A new release of the desktop-oriented distribution GhostBSD 23.10.1, built on FreeBSD 13-STABLE and offering the MATE user environment, has been published. By default, the ZFS file system is used in GhostBSD. It supports both Live mode and the installation on the hard drive (using their own installer, written in Python). The boot images are built for x86_64 (2.5 GB) architecture.

https://www.ghostbsd.org/news/GhostBSD_23.10.1_Now_Available

RELEASE OF INCUS 0.2:
31/10/2023

The second edition of the Incus project is presented, where the Linux Containers community is developing a fork of the LXD container management system, created by the old development team that once created LXD. The Incus code is written in GO and is...
**NEWS**

**RELEASE OF VLC 3.0.20:**
31/10/2023

Unscheduled corrective release of VLC 3.0.20 is available, in which a potential vulnerability (CVE is not assigned) The vulnerability can theoretically be exploited when you try to load content from malicious servers using the URL "mms://." It notably fixes a crash with AMD GPU, a green line in full screen on Windows, a crash with AV1 hw acceleration and a bug in the full screen panel.

https://code.videolan.org/videolan/vlc/-/tags/3.0.20

**MIDORI 11 WEB BROWSER BASED ON THE FLOORP PROJECT:**
31/10/2023

The company Astian, which in 2019 absorbed the Midori project and turned it into a scummy harvesting browser, introduced a new branch for Midori 11, which has moved to the Mozilla Gecko engine, used in Firefox. The main development goals of Midori is concern for user privacy and lightness is mentioned - the developers set themselves the task of making a browser that is most undemanding among Firefox products and suitable for work even on outdated systems. The project code is distributed under the MPLv2 license. The builds are prepared for Linux, Windows and macOS.

The Midori 11 code repository is open source and created by borrowing the floorp codebase developed by a group of Japanese students and combining the Firefox engine with Chrome-style capabilities and interface. Midori 11 is similar to the floorp-11 line. It is noted that the version was made in conjunction with the team of Floorp developers, cooperation will continue in the future.


**RELEASE OF PALE MOON 32.5:**
01/11/2023

The release of Pale Moon 32.5, using the Firefox code base to provide higher efficiency, protect the classical interface, minimize memory consumption and provide additional customization options, has been released. Pale Moon builds are made for Windows and Linux (x86_64). The project code is licensed under the MPLv2 (Mozilla Public License).

Compared to Firefox, the browser returned support for extensions using XUL, and the possibility of using both full and lightweight themes were saved.


**RELEASE OF YGGDRASIL 0.5:**
01/11/2023

After more than two years of development, the release of the reference implementation of the Yggdrasil 0.5 protocol, which runs on top of the conventional global network to deploy a separate decentralized private IPv6 network, to protect privacy, which uses end-to-end encryption, was announced. The Yggdrasil network can use any existing IPv6
applications. The code is written in GO and is distributed under the LGPLv3 license. Linux, OpenWRT, Windows, macOS, FreeBSD, OpenBSD, VyOS and Ubiquiti EdgeRouter platforms are supported.

Yggdrasil is developing a new routing concept to create a global decentralized network, nodes in which can be connected both directly in mesh-network mode (for example, via Wi-Fi or Bluetooth), and interact on top of existing IPv6 or IPv4 networks (a network on top of the network). A distinctive feature of Yggdrasil is the self-configuration that does not require an explicit routing setting - route information is calculated, starting from the location of the node in the network relative to other nodes. Devices are addressed via a regular IPv6 address that does not change if the node is moved (the unused range of addresses 0200::/7 is used in Yggdrasil).

The entire Yggdrasil network is not considered as a combination of disparate subnets, but as a single structured backbone tree that has one "root," and each node has one parent and one or more children. This tree structure allows you to build a route to the destination node, relative to the source node, using the "locator" mechanism that determines the optimal path to the node from the root. Information about the tree is distributed between nodes and is not stored centrally.

https://yggdrasil-network.github.io/

AUDACITY 3.4: 02/11/2023

A release was announced of the free audio editor Audacity 3.4, which provides audio editing tools (Ogg Vorbis, FLAC, MP3 and WAV), audio recording and digitization, changes in the parameters of the sound file and overlay tracks and application of effects (e.g. noise suppression, tempo change and tone). Audacity 3.4 was the fourth significant release formed after the transfer of the project to the hands of the Muse Group. The Audacity code is distributed under the GPLv3 license, binary builds are available for Linux, Windows and macOS.

http://www.gnu.org/software/gawk

NEW VERSION OF THE GNU AWK 5.3 INTERPRETER: 02/11/2023

After a year of development, a new release of the AWK programming language from the GNU - Gawk 5.3.0 project is presented. AWK was developed in the 70s of the last century and has not undergone significant changes since the mid-1980s. The main backbone of the language was determined, which allowed the preservation of the pristine stability and simplicity of the language over the past decades. Despite the advanced age, AWK is still actively used by administrators to perform routine work related to the analysis of various types of text files and the generation of simple-stating statistics.

https://nxos.org/changelog/release-announcement-nitrux-3-1-0/

RELEASE OF NITRUX 3.1: 02/11/2023

A release of the Nitrux 3.1 distribution, built on Debian, KDE technologies and the OpenRC initialization system, has been published. The project offers its own NX Desktop desktop, which is an add-on over KDE Plasma. A set of typical user applications is developed, which can be used on both desktop and mobile devices, based on the Maui library. AppImages is being promoted to install additional applications. The full loading image is 3.3 GB. The project is distributed under free licenses.

The NX Desktop desktop offers a different style design, its own implementation of the system tray, notification output center and various plasmoids, such as a network connector and multimedia applet to control the volume and control the playback of multimedia content. Applications created using the MauiKit framework, you can note the file manager Index (you can also use Dolphin), text editor Note, Station terminal emulator, VVave music player, Clip video player, NX Software Center application center and Pix image viewer.
**OpenELA Repositories for RHEL-Compatible Distributions:**
03/11/2023

The OpenELA (Open Enterprise Linux Association), formed in August by CIQ (Rocky Linux), Oracle and SUSE to combine efforts to ensure compatibility with RHEL, announced the readiness of a package repository, which can be used for creating distributions that are fully binary compatible with Red Hat Enterprise Linux. The original code of the prepared packages are distributed free of charge and without restrictions.

The new repository is supported by the development teams of Rocky Linux, Oracle, Linux and SUSE Liberty Linux and includes packages that are compatible with RHEL 8 and 9. In the future, they plan to publish packages for distributions that are compatible with the RHEL 7 branch. In addition to the source packages, the project also intends to distribute the tools necessary to create derivatives that are fully compatible with RHEL.

The OpenELA repository promises to maintain, using a fully open development process, provide prompt publication of updates and vulnerabilities. The project is open, independent and neutral.

**https://openela.org/news/2023.11.02-governance_and_code_availability/**

**Release of Radix Cross 1.9.212:**
03/11/2023

The latest version of the Radix cross Linux 1.9.212 built using its own Radix.pro builder, that simplifies the formation of distributions for embedded systems, is available. Distributed structures are available for devices based on ARM/ARM64, MIPS and x86/x86_64 architectures. The boot images are prepared according to the instructions of the Platform. Download section contains a local package repository and therefore the installation of the system does not require connection to the Internet. The build system code is distributed under the MIT license.

With 1.9.212 they added the build for the Orange Pi5 device based on the SoC RK3588s. Instructions for installing or using images as Live-CD can be found in the Install section.

**https://radix.pro/platform/install/**

**New Version of Exim 4.97 Mail Server:**
04/11/2023

A release of Exim 4.97, which included accumulated bug fixes and added new features, is out. According to the November automated survey of about 700,000 mail servers, the share of Exim is 58.73% (a year ago 60.90%), compared to Postfix at 34.86% (32.49%), Sendmail - 3.46% (3.51%), MailEnable - 1.84% (1.91%), MDaemon - 0.40% (0.42%), Microsoft Exchange - 0.19% (0.20%) of mail servers.

**https://lists.exim.org/lurker/message/20231104.135832.37148bbd.en.html**

**Release of Libreboot 20231106:**
06/11/2023

A release of free bootable firmware, Libreboot 20231106 was published. The update was assigned the status of a test release (stable releases are published about once a year, the last stable release was in June). The project develops the finished build of the coreboot project, which provides replacement of proprietary firmware UEFI and BIOS, responsible for the initialization of the CPU, memory, peripherals and other motherboard connections, with the minimization of binary inserts.

Libreboot is aimed at forming a system environment that allows you to do without proprietary software as much as possible, at the firmware level. Libreboot complements Coreboot with for end users, forming a ready-made distribution that can be used by any user who does not have special skills.

In the new release support was added for the Intel D945GCLF motherboards. In a separate
NEWS

branch, they put the development of firmware for the Dell Latitude E6400. There have been many changes to the build system.

https://libreboot.org/docs/hardware/d945gclf.html

**OmniOS CE r151048 and OpenIndiana 2023.10:**
07/11/2023

The OmniOS Community Edition r151048 is out, based on the work of the illumos project and providing full support for bhyve and KVM hypervisors, the crossbow virtual network stack, the ZFS file system and the means to run lightweight Linux containers. The distribution can be used both to build scalable web-systems and to create storage systems.

https://omnios.org/article/r48

**Release of SAIL 0.9.0:**
07/11/2023

A release of the C/C++ library of image decoding SAIL 0.9.0, which can be used to create image viewers, upload images to memory, download resources in game development, etc. was announced. The library continues to develop ksquirrel-libs image format decoders from the KSquirrel program, which were rewritten from C++ and C. The KSquirrel program has been in existence since 2003 (today the project is exactly 20 years old), but the development was discontinued in 2008 along with KDE3. The SAIL code is licensed under the MIT license. Supported on Windows, macOS and Linux.

https://github.com/HappySeaFox/sail/releases/tag/v0.9.0

**Release of Mineclonia 0.91 game created on Minetest engine**
11/7/2019 11:14 PM

A n update of the game Mineclonia 0.91, was announced. It is made on the Minetest engine and is the fork of the Mineclone 2 game, providing a similar game to Minecraft. The fork is still being developed, the focus is on improving stability, expanding functionality and optimizing performance. The project code is written in Lua and distributed under the GPLv3 license. The new version has been refining villages and residents, updated hudbars and improved game physics.

https://content.minetest.net/packages/ryvnf/mineclonia/

**Permission to redistribute the firmware:**

https://content.minetest.net/packages/ryvnf/mineclonia/

**Release of Fedora Linux 39:**
07/11/2023

A release of the Fedora Linux 39 distribution is out. Fedora Workstation, Fedora Server, Fedora CoreOS, Fedora CoreOS, Fedora Cloud Base, Fedora IoT Edition and Live-builds - KDE Plasma 5, Xfce, MATE, Cinnamon, LXDE, Phosh, LXQt, Budgie and Sway are prepared. The builds are formed for x86_64, Power64 and ARM64 architectures. The publication of the Fedora Silverblue builds are delayed.

https://fedoramagazine.org/announcing-fedora-linux-39/

**GIMP 2.10.36:**
08/11/2023

GIMP 2.10.36 has been published. Packages in flatpak and snap format will be published for installation in the near future. The release mainly includes bug fixes and small improvements. All efforts to increase functionality are focused on the preparation of the GIMP 3 branch, which is in the testing stage of preliminary releases. It is expected that GIMP 2.10.36 will be the penultimate release in the 2.10 branch and next year will see GIMP 3.0.


**Ubuntu Touch OTA-3 Focal:**
08/11/2023

The UBports project, which took over the development of the Ubuntu Touch mobile platform, after Canonical moved away from it, introduced the firmware: OTA-3 Focal (over-the-air). This is the third release of Ubuntu Touch, based on the Ubuntu 20.04 (old releases were based on Ubuntu 16.04). The
The distribution is based on Debian GNU/Linux and uses the code of projects such as DRBL, Partition Image, ntfsclone, partclone, udpscast. It is possible to use it from CD/DVD, USB Flash and via the network (PXE). It supports LVM2 and FS ext2, ext3, ext4, reiserfs, reiserfs, reiser4, xfs, jfs, btrfs, f2fs, nilfs2, FAT12, FAT16, FAT32, NTFS, HFS+, UFS, minix, VMFS3 and VMFS5 (VMWash ESX). There is a mode for mass cloning over the network, including the transfer of traffic in a multicast mode, which allows you to clone the original disk on a large number of client machines at the same time. You can clone from one disk to another, and creating backups by saving the disk image to the file. You can clone at the level of entire disks or individual partitions.


**Release of Clonezilla Live 3.1.1:**
08/11/2023

The release of Clonezilla Live 3.1.1, designed for fast cloning, (accessing only used blocks) is out. The tasks performed by the distribution are similar to the proprietary product Norton Ghost. The size of the distribution iso-image is 417MB (i686, amd64).

**LG has published webOS Open Source Edition 2.24:**
09/11/2023

The release of the open platform webOS Open Source Edition 2.24, which can be used on various portable devices, boards and car and entertainment systems, is presented. The Raspberry Pi 4 boards are considered as the reference hardware platform. The platform is developing in the public repository under the Apache 2.0 license, and the development is supervised by the community, adhering to a joint development management model.


**GNOME PROJECT RECEIVED A MILLION EUROS FOR DEVELOPMENT:**
10/11/2023

GNOME Foundation has received a million euros from the Sovereign Foundation in Germany to stimulate the development of open digital and open source ecosystems. The fund was created with funds provided by the German Ministry of Economy and Climate Protection and is supervised by the Federal Agency for Subversive Innovation SPRIND. The money received is planned to be spent on upgrading the GNOME platform, improving tools, expanding funds for people with disabilities and implementing functions of public interest.

In particular, they plan to develop a prototype of a new stack for people with disabilities and make improvements to the existing stack, to provide support for selective encryption of home directories of users, modernize the storage of passwords and keys, improve the quality of equipment support, improve quality control, expand the Freedesktop API and work on the consolidation and improvement of the platform components.

In addition to GNOME, the Sovereign fund also supports open projects such as OpenSSH, WireGuard, Python, RubyGems, curl, OpenBGPd, OpenPm.j.js/GopenPGP, Pendulum, Sequoia PGP and Yocto. The amount of support for these projects is not specified. Applications from significant open projects for financing continue to be accepted. The total budget for 2023 is EUR 11.5 million.
RELEASE OF BACKBOX LINUX 8.1: 10/11/2023

After a year of development, the release of BackBox Linux 8.1, based on Ubuntu 22.04 and supplied with a collection of tools for security checks, testing exploits, reverse engineering, analysis of network traffic and wireless networks, malware research, stress testing, detection of hidden or lost data. The user environment is based on Xfce. ISO-image size 4.2 GB (x86_64). The new version notes an update of the Xfce environment and the Linux kernel (5.15), the supply of new versions of security verification tools and updating the ISO-feature built in hybrid format and adapted for download on UEFI systems.

http://linux.backbox.org/

AVAILABLE VORTEX 2.0: 11/11/2023

The second edition of the Vortex project, developing an open GPGPU based on the RISC-V architecture, designed to perform parallel computing using the OpenCL API and the SIMT (SingLending, Multiple Threads) model, was published. The project can also be used in 3D graphics research and in the development of new GPU architectures. Drivers and accompanying project documentation are distributed under the Apache 2.0 license.

The GPGPU is based on a typical ISA RISC-V, extended by some additional instructions necessary to support GPU functions and flow management. In this case, changes in the architecture of the RISC-V command set are minimized and existing vector instructions are used if possible. A similar approach is used in the RV64X project, which also develops an open GPU based on RISC-V technology.

http://linux.backbox.org/

https://github.com/vortexgpgpu/vortex/releases/tag/v2.x

RELEASE OF FFMPEG 6.1: 11/11/2023

After ten months of development, the multi-media package FFmpeg 6.1, is available, including a set of applications and a collection of libraries for operations on various multimedia formats (recording, converting and decoding of sound and video formats). The package is distributed under the LGPL and GPL licenses. Development of FFmpeg is carried out with the MPlayer project.

http://ffmpeg.org/download.html#releases

OBS STUDIO 30.0: 12/11/2023

OBS Studio 30.0, a suite for streaming, compositing and video recording, is now available. The code is written in C/C++ and distributed under the GPLv2 license. Builds are created for Linux (flatpak), Windows and macOS.

Support is provided for compositing with scene construction based on arbitrary video streams, data from web cameras, video capture cards, images, text, the contents of application, windows, or the entire screen. During broadcasting, you can switch between several predefined scenes (for example, to switch views with an emphasis on screen content and webcam image). The program also provides tools for audio mixing, filtering using VST plugins, volume equalization and noise reduction.

https://obsproject.com/
The VirtualBox Networking Primer

Connecting and Configuring Virtual Machines

The VirtualBox Networking Primer is a no-nonsense guide for the VirtualBox user taking their next steps into virtual networks.

While Oracle VM VirtualBox is a great free tool, the real power of virtualisation comes when you start connecting virtual machines to each other and to the wider world. Software development, sales, education and training are just some of the areas in which network access to virtual machines offers endless opportunities. But the world of computer networks is filled with complex technical jargon.

Complete with principles, practice, examples and glossary, The VirtualBox Networking Primer takes the frustration and confusion out of connecting real-world projects.

Author: Robin Catling
Publisher: Proactivity Press
ISBN13 : 9781916119482


Amazon UK link: [https://www.amazon.co.uk/VirtualBox-Networking-Primer-Connecting-Configuring/dp/1916119484/ref=sr_1_1?dchild=1&keywords=virtualbox+networking+primer&qid=1600253699&s=books&sr=1-1](https://www.amazon.co.uk/VirtualBox-Networking-Primer-Connecting-Configuring/dp/1916119484/ref=sr_1_1?dchild=1&keywords=virtualbox+networking+primer&qid=1600253699&s=books&sr=1-1)

Now that you know how to create your own web server, I want us to look into web applications. For this we will start with Docker. Now if you know what a Snap package is, well that is basically what Docker is for web applications.

Again, we will go for the low-hanging fruit and get you started as fast as I know how. (There is a lengthy install instruction on the docker homepage, but we are taking the easy route - Thanks @fleabite08). I’m going to assume you are using Ubuntu desktop.

**Installation:**

Open your terminal and type:

```
sudo apt install docker.io -y
```

Once it has completed, type

```
sudo docker -v
```

OK, we have Docker, now what? Well, we need a web application. Something like Redis, but as we are starting out, let’s set our aim lower.

Something everyone can appreciate and understand.

Docker has a central repository, if you will, for all these application images. Some are public and some are private. You can go look at the images available - [https://hub.docker.com](https://hub.docker.com) - and there will be instructions on how to get them. A quick word: like any public repository, anyone can publish to the docker hub. Try to eyeball official applications, that is, look for the verified publisher and checkmark.

**Let us try it out:**

Type:

```
sudo docker run docker/whalesay cowsay boo
```

- docker run – is the initialisation command
- docker/whalesay - is the image location on docker hub.
- cowsay hello – is the message you want to output in the app.

So as you can see, it is not difficult.

So what happened when you typed the command?

Docker looked to see if you already had the application, and then started pulling it from Docker hub.

Let’s try a basic command, type:

```
docker ps
```

Everyone makes mistakes. On some distros, you cannot log in as root and you will need sudo. Be sure you have sudo or root access. As my container is no longer running, I do not see it with docker ps. I need to tack on -a, to see ALL the containers. This is the thing about containers. They are usually created to do one job, then exit, but you can have applications that continue running. To stop a running container, the keyword is stop. Can you guess the command? Stopping a container requires either its name or its ID. If you look at either, you can see it is a few characters.
COMMAND & CONQUER

Erik has been in IT for 30+ years. He has seen technology come and go. From repairing washing machine sized hard drives with multimeters and oscilloscopes, laying cable, to scaling 3G towers, he's done it.

However, you just need to type enough for it to be unique. In our case, we have only the one, so it is easy, but if you have many, you need to be very careful here. The command: sudo docker stop <the name of YOUR container>

If you were on the ball, you may have noticed in our command output from “docker ps -a” that the status says exited.

Now that our container came to life, did its job, and died again, we may be done with it. Time to free up some disk space. To remove a container, the command is rm, just like in the shell. To do this, the container needs to be stopped or exited. Type:

```
sudo docker rm <the name of YOUR container>
```

Though the container is now gone, there is still the locally cached image that you grabbed from Docker hub on your PC, making reinstallation really quick. To see what images are stored on the local machine, use the following command: sudo docker images

```
REPOSITORY TAG IMAGE ID CREATED SIZE
docker/whalesay latest 6b362a9f73eb 8 years ago 247MB
```

```
ed@mate22:$ sudo docker ps -a
CONTAINER ID IMAGE COMMAND CREATED STATUS
6b362a9f73eb6e docker/whalesay "cowsay boo" About an hour ago Exited (0) About an hour ago
crazy_bhaskara
ed@mate22:$ sudo docker rm crazy_bhaskara
crazy_bhaskara
ed@mate22:$ sudo docker ps -a
CONTAINER ID IMAGE COMMAND CREATED STATUS PORTS NAMES
```

Just to make sure you do not accidently delete the image with the rm command, to remove an image, there is a separate command, rmi. You need to make sure that no containers are running off an image, before you remove it.

Try it yourself.

If you get an error that it cannot find your image, simply use the ID. Remember what I said earlier of it having to be unique? In my case, I have only the one, so I can type: sudo rmi 6b and it will be removed.

```
Is yours gone yet?
```

We can grab the image again if needed, simply pull it: sudo docker pull docker/whalesay - and it will download it again, without running it.

```
Homework:
```

Grab the Ubuntu image and run it.

What happened???

We will discuss this in the next issue.

As always, if we are boring you, drop us a line at: misc@fullcirclemagazine.org

---

File Edit View Search Terminal Help

ed@mate22:$ sudo docker ps -a
CONTAINER ID IMAGE COMMAND CREATED STATUS
PORTS NAMES
6b362a9f73eb6e docker/whalesay "cowsay boo" About an hour ago Exited (0) About an hour ago
crazy_bhaskara
ed@mate22:$ sudo docker rm crazy_bhaskara
crazy_bhaskara
ed@mate22:$ sudo docker ps -a
CONTAINER ID IMAGE COMMAND CREATED STATUS PORTS NAMES
ed@mate22:$
Greetings again, fellow Beings. I hope your October (and November so far) has been happy. This month, I will take a look at the TkinterMapView library. You can find it at https://github.com/TomSchimansky/TkinterMapView

As I usually do, I used PAGE 7.6 (the current release) to throw together a GUI for the demo. Besides the fact that I’m too lazy to make the demo directly in Tkinter, this shows how easy it is to create a map viewer within PAGE without having to use a custom widget.

Below is an image that shows the demo in the PAGE designer. You can see how simple the GUI is to put together.

While all of the widgets I used to create the demo are ttk widgets (with the exception of the ScrolledListbox), you can easily change that to use standard Tk widgets. There is nothing special about the widget set. As you can see, there are only two Frames, two Labels, six Buttons, one TEntry and the ScrolledListbox, so if you decide to forgo the use of PAGE for Tkinter, it won’t take you too much coding to recreate it. The only things I “hard coded” in PAGE are the widget alias for the buttons, the button callback names and the text variable for the TEntry widget.

Once I had my GUI designed, I saved the PAGE project, and generated the GUI and Support Python modules.

Before you start coding your demo, you will need to install the library, using pip (or pip3):

```python
pip3 install tkintermapview
```

Now that you have your system ready for the project, let’s look at the support module. Remember, PAGE creates skeletons of all the callbacks and the base code for showing the Tkinter program.

First, we need to start with the imports. As I usually do, I’ll show the entire code for the functions, but when it comes to the PAGE function skeleton code, I’ll put the code you would need to add in bold and the rest of the code in “normal” face.

```python
import sys
import platform
import os

Next to last, we need to import the tkintermapview library. Since the program won’t run at all
```
without this library, I add the try\nexcept catch to provide information

to the user that the library isn’t

Try:

from tkintermapview import TkinterMapView
except:
msg = “You must install
tkintermapview using pip.”
print(msg)
sys.exit()

Finally, the GUI.py file is
imported so our GUI definitions are

import tkintermapviewdemo

Top right is the main function,
which again, PAGE creates for us.
The only thing that needs to be
added is a call to the startup
function, which provides
initialization code for the program.

The startup function (below) is
not part of the PAGE provided
skeleton sets, so everything is
added. First we set a few globals,
create an empty list called
markerList, define the default
zoom level for the map, and insert
the TkinterMapView widget into
the second TFrame. Make sure you
include the .place(x=0,y=0) line so
the widget completely fills the
TFrame.

Next, we provide a starting
location for the Map widget. I
decided to use one of my favorite
spots in the world, Garden of the
Gods in Colorado. This returns a
pointer to the location object. I set
the marker option to True. Then tell
the map widget to use the
defaultZoomLevel, and add the
marker pointer to the markerList
list and create a variable named
cntr For the item number in the List
box.

I then add the text to the Entry
widget, insert the text (with the
counter number) into the
ScrolledListbox. Then I call the
set_bindings function to deal with
the bindings needed, show the
environment debugging
information. Next I disable the
CreateMarker button, since it was

for future development, set the
title bar, and center the Toplevel
widget in the user’s screen (next
top, right).

With the startup function
finished, we can now look at some
of the other functions that I use to
support the program.

This (next page, bottom right) is
the show_environ_info function. It
basically shows some generic
system information in the terminal
when the program gets run.

The set_bindings function (next
page, top left) does what the title
says. It sets the bindings for the
Entry widget and the
ScrolledListbox.

Here is the keypress callback for
the Entry widget, which will call the
on_btnGo function when the user
hits the Enter key.
def set_bindings():
    _w1.TEntry1.bind("<KeyRelease>", lambda e:
                    on_entryKeyPress(e))
    _w1.TEntry1.bind("<Button-3>", lambda e:
                    on_EntryBtn3(e))
    _w1.Scrolledlistbox1.bind("<ListboxSelect>",
                                on_listboxSelect)

def on_entryKeyPress(e):
    if e.keysym == "Return":
        on_btnGo()

Since the Map widget supports right-clicking on the map to get the Latitude and Longitude of the click point, I've included the ability of right-clicking in the Entry widget to allow the pasting from the clipboard (bottom left).

When the user clicks on an item in the ScrolledListbox, this code set will "recall" the location from the listbox and cause the map widget to recentre the map location (bottom right).

Now it's time to fill in the code for all of the callback functions for our buttons. Remember, PAGE creates the skeleton functions, so only the code that you need to add will be in bold.

The ClearMarkers callback will go through the marker list and use the map_widget.delete() method, then all the markers in the ScrolledListbox will be deleted. Notice this delete ALL markers (next page, top right).

The ClearPath callback simply calls the map_widget.delete_all_path method. It draws a line on the map between the markers (next page, bottom left).

The CreatePath callback walks through the list of markers and calls the map_widget.set_path method. It draws a line on the map between the markers (next page, bottom left).

This final function simply centres the project in the user’s screen.

def on_listboxSelect(e):
    indx = _w1.Scrolledlistbox1.curselection()
    itm = _w1.Scrolledlistbox1.get(indx[0])
    # SelectedItem.set(f"Selected Item: {indx[0]} - {itm}")
    if _debug:
        print(f"Selected Item: {indx[0]} - {itm}")
    search_marker = map_widget.set_address(itm, marker=False)
    map_widget.set_zoom(defaultZoomLevel)

def on_EntryBtn3(e):
    if _debug:
        print("on_EntryBtn3")
    currentPos = root.clipboard_get()
    if currentPos != "":
        _w1.search_address.set(""")
        _w1.search_address.set(currentPos)
    on_btnGo()
The btnGo callback gets the address (or coordinates) from the Entry widget then calls the map.widget.set_address method to create a place on the map. We automatically call the method with the marker=True parameter to make sure there is a marker on the map. The return from the method is checked to see if the get address search was successful. If so, the marker is added. If not, an error message box will be shown to the user (next page).

That’s it. The program should now run and allow you to show maps, markers and paths.

def on_btnClearMarkers(*args):
    if _debug:
        print("tkintermapviewdemo_support.on_btnClearMarkers")
        for arg in args:
            print("    another arg:", arg)
        sys.stdout.flush()
    global markerList
    for ml in markerList:
        map_widget.delete(ml)
    _w1.Scrolledlistbox1.delete(0, len(markerList))
    markerList = []

def on_btnClearPath(*args):
    if _debug:
        print("tkintermapviewdemo_support.on_btnClearPath")
        for arg in args:
            print("    another arg:", arg)
        sys.stdout.flush()
    map_widget.delete_all_path()

def on_btnCreatePath(*args):
    if _debug:
        print("tkintermapviewdemo_support.on_btnCreatePath")
        for arg in args:
            print("    another arg:", arg)
        sys.stdout.flush()
    positionList = []
    for marker in markerList:
        positionList.append(marker.position)
    if len(positionList) > 0:
        markerPath = map_widget.set_path(positionList)

def on_btnExit(*args):
    if _debug:
        print("tkintermapviewdemo_support.on_btnExit")
        for arg in args:
            print("    another arg:", arg)
        sys.stdout.flush()
    sys.exit()
def on_btnGo(*args):
    if _debug:
        print("tkintermapviewdemo_support.on_btnGo")
        for arg in args:
            print("    another arg:", arg)
        sys.stdout.flush()
    address = _w1.search_address.get()
    search_marker = map_widget.set_address(address, marker=True)
    if search_marker == False:
        search_marker = None
        titl = "MapView1 Search Error"
        msg = "The search entry could not be found."
        messagebox.showerror(titl, msg, parent=_top1, icon=messagebox.ERROR)
    else:
        markerList.append(search_marker)
        cntr = len(markerList)
        _w1.Scrolledlistbox1.insert(cntr, address)
        map_widget.set_zoom(defaultZoomLevel)

The TkinterMapView widget provides MUCH MUCH more functionality than I've explored here. I strongly suggest you visit Tom's GitHub repository and download the code so you can get more documentation and his example programs.

I've created a repository on GitHub for the code for this project. You can find it at https://github.com/gregwa1953/FCM-199

Until next time, as always; stay safe, healthy, positive and creative!
In the last part of this series, I mentioned I would add an example image at the beginning and end of each article with prompts to show the ease of creating images. I normally create 20 images and choose what I deem the most appropriate. All the prompt information is not necessary unless you want to get a very similar image. Using Automatic1111, the prompt is the underlined text below with additional image settings:

- A penguin overlooking a ledge looking at a frozen Central Park and New York City, highly detailed, very intricate, cinematic lighting
- Steps: 20, Sampler: Euler a, CFG scale: 14, Seed: 1609724340, Size: 1024x1024, Model hash: 31e35c80fc, Model: sd_xl_base_1.0, Style Selector Enabled: True, Style Selector Randomize: False, Style Selector Style: base, Version: v1.5.1

In part nine of An Introduction to Stable Diffusion, we will look at the sd-webui-prompt-all-in-one (PAIO) extension on the Automatic1111 interface of Stable Diffusion 1.0. It is the significant number of ever increasing extensions that makes Automatic1111 the choice for many SD users. This extension is, as the name implies, an attempt to make all types of modifiers available through a click-based format.

To install PAIO or any other extensions, select the Extensions tab in the Automatic1111 interface as shown. The current state and installed extensions are shown. You might want to Check for updates and then Apply and restart UI as seen in the interface. You will notice that I already have the PAOI extension installed. If you don’t have it installed, select Available from the interface, and then select the Load from button to show the many options. To find it faster, search for prompt-all-in-one (CTRL + f) and install using the install button on the far right in the Action column.

Once installed, the button to the

![Penguin Image](image-url)
HOWTO - STABLE DIFFUSION

left of the Prompt (red arrow below) lets you Show or Hide the Panel, and the similar button to the right (red arrow) lets you show or hide the Group Tags. The numbers to the right of the word Prompt (yellow arrow) show the number of prompts used of the maximum 75. If neither are shown, use the buttons to show the Panel and then the Group Tags.

For example, if the panel is shown, you could type in 'early teen' in the Please Enter New Keyword box because it’s not an option specified, or any other parameters you want to make sure are included in the prompt. Then select Person, Wings and bat_wings, then female, Wings and black_wings to produce the prompt shown. You need not type in anything but you can create a prompt using both typed input and PAOI selections (bottom right).

There are many listed options; for example, under Person view Object selecting Eyes or Ears. Many are derived from other languages or are abbreviations which may be unfamiliar, but as you become more familiar it increases the possibilities. While the results are unimpressive with a limited prompt, making 20 images helps to suggest various options when the user is unsure of what direction to go to meet the desired need. You can always type in descriptors if you know what direction you want to pursue. Individual prompts can also be modified by moving the cursor over the prompt, ‘early teen’ in this case. Various options to delete and modify Keyword and Keyword weight are then available which is likely easier than modifying individual prompts if the list already has several words.

The final image below is produced using Easy Diffusion. It’s a bit late for All Hollows’ Eve but maybe for next year. Starting with a prompt of = "detailed chocolate skull, chocolate candies, [tequila bottle with two glasses], in Mexican cemetery, at sunset, high resolution, burning candle" and "seed": 2524754007, "use_stable_diffusion_model": "sd_xl_base_1.0", "clip_skip": false, "use_controlnet_model": null, "use_vae_model": "", "sampler_name": "euler_a", "width": 1024,"height": 1024, "num_inference_steps": 25, "guidance_scale": 7.5, "use_lora_model": null, "use_embeddings_model": null, "tiling": null, "use_face_correction": null, "use_upscale": null", you should be able to get a somewhat similar image.
HOW-TO
Written by Robert Boardman

This might be the easiest and simplest task to do in Latex that we have encountered.

To add hypertext links to a document, add the hyperref package to the document preamble. According to the documentation, it must be the last package. In the cookbook I have been building, that means the use package instruction will now look like this:

```
\usepackage{inputenc, cooking, cooking-units, makeidx, hyperref}
```

As you can see in Figure 1, there are now links in the Table of Contents to all of the chapter headings. This happens automatically with the hyperref package. The formatting you see is the default formatting with this package. I do not like the red boxes around each link, and I will change those using features of the hyperref package.

Looking at the recipe for Steamed Buns, you can see a citation. There is also a hot link to the work in the Bibliography to match this citation. This kind of link has a green box around it, again it’s not the formatting I like, so I hope to change it.

I did not build any links for the items in the Glossary. I could add those links into the relevant files. I note there is no way in the initial document to return to the Table of Contents after having read a recipe. I will also take a look at using the Table of Contents to make a Bookmarks column in the generated PDF.

Formatting links

In order to learn how to format the automatically generated links using hyperref, I read through the documentation for the hyperref package. I know reading the manual
HOWTO - LATEX

is counter-intuitive for many people involved in IT. Things should be self-explanatory. I agree – most software should be self-explanatory, but most software is not. That is why software developers write manuals. If you intend to use an unfamiliar package in your work with Latex, I encourage you to read any documentation that comes with the package and / or read the relevant pages in The Latex Companion by Mittelbach and Fischer. (The third edition was released earlier this year, ISBN 978-0-465894-0.)

The documentation that comes with the hyperref package is not beginner-friendly. In particular, it could use more examples. Perhaps a separate document containing examples would be better than more text. A large number of possible options are available. In the case of this cookbook, I wanted some indication there were links, but I wanted to eliminate the boxes. I used the instruction \hypersetup with two options.

\hypersetup{pdfborder=0 0 0, colorlinks=true}

The default for pdfborder is 0 0 1. Setting the last digit to 0 turns off the boxes. Having any positive value as the last digit makes the boxes visible. I used colorlinks=false, no color for any of the hyperlinks. As you can see from the image, all of the text in the Table of Contents is now red, with no boxes or lines. If you view the PDF, the mouse cursor will change shape to indicate clickable links. The “back links” from recipes to the Table of Contents are also red. Links to the Bibliography are indicated by green text.

**Links to Glossary**

Setting up links between text in the recipes and the Glossary is not difficult. I could use the same process described in Return links to the Table of Contents. However, the return links should all point back to the same spot unless you want to make a lot of “back links” in the Glossary. For example, there is an entry in the Glossary for sesame oil. Several recipes use sesame oil. Several recipes use sesame oil. (Check the index to see how many pages have this ingredient.) You could set up separate links to every recipe using sesame oil. Then the reader would have to choose which one to get back to the recipe they were reading or using. Having all the back links point to the Table of Contents means the reader would need to remember which recipe they were using, then click from the Glossary to the Table of Contents, and then to the recipe they wish to use. While this is a little inconvenient for the user, it simplifies the coding, greatly reduces the time needed for coding, and generates only one back link for each entry in the Glossary, not one back link for every recipe where a specific ingredient occurs.

The simplest approach would be to put “see Glossary” in parentheses after the name of the ingredient. That might get tedious for the reader and would certainly get tiresome to input all those extra bits of text. Another solution would be to make a footnote in each recipe that contained an ingredient listed in the Glossary. The footnote would be “see Glossary”. Again that would be tiresome to type (or copy and paste) in all the relevant recipes but not so obtrusive for the reader. Neither of these methods takes advantage of the electronic links that are available with Latex in an on-screen PDF.

Ideally, every item in the Glossary would be matched to a pop-up item. If the user of the book hovers over an unknown term a box would pop up giving the information in the glossary. If I add the pdfcomment package to the document, this kind of popup or comment or annotation can be made available in the PDF version of the document. I hope it is obvious why popups are not available in printed documents. I hope it is also obvious why popups for the glossary are not necessary in a printed copy of this cookbook.

A simple electronic solution for chapter navigation would be a bookmark system, very common in PDF (and HTML) files – see below for PDF bookmarks.

**Return links to Table of Contents**

To go from one place in a document to another, the clickable link has to be coded and the target for the link also has to be coded. One way to do this is to use label and pageref instructions. The
Howto - Latex

Target, the Table of Contents, has to include an appropriate label.

```latex
\label{toc}
```

Once the hyperref package is being used, the pageref information automatically becomes a clickable link in the PDF document.

```latex
\pageref{toc}
```

Label names have to be unique within a document (or set of documents which is what we have built). I chose “toc” because it is easy to remember and obviously identifies the Table of Contents. However any alphanumeric combination is acceptable. The sentence I used is:

```
Return to Table of Contents
\pageref{toc}
```

That is clear enough for just about anyone to understand, I think.

Table of Contents to Bookmarks

This is the easiest part. There is nothing to be done. Use a regular PDF document viewer to open the generated PDF document. The bookmarks are not visible in the view of the PDF document in Texstudio. However a regular PDF viewer will show you the Table of Contents as standard PDF bookmarks. If you do not see them, go through the menus in the PDF viewer and turn the bookmarks on.

Next Time

Next issue, I will experiment with modifications of the title page. It needs to look more professional than standard text. After that, I will be ready to finish modifying this little cookbook and move on to another project using Latex.
Kilobyte Magazine is a fanzine for 8bit enthusiasts. It covers consoles, computers, handhelds and more, as well as new games for old systems. If you grew up with Commodore, Atari, Sinclair or Amstrad, this magazine is for you.

https://retro.wtf/kilobytemagazine/
Last month, I spent the entire article looking at the Path > Split Path operation that was added in version 1.2. Although version 1.3 added two more path operations, they’re essentially two variations on the same theme, so won’t take quite as much space to describe. These are Path > Flatten and Path > Fracture. Let’s begin with an example that consists of a star drawn over a rectangle:

You probably give little thought to such layering of elements, which you undoubtedly use all the time in your Inkscape projects. But to understand how these new operations work, it’s important to comprehend what’s actually happening in terms of the SVG content. Both these objects are in the same layer, but they live at different positions in the Z-stack, usually determined by the order in which they appear in the file. This is the “painter’s model” that SVG uses – earlier objects in the file can be “painted over” by later objects. In this case, the blue star is painted over the red rectangle, and since there’s no transparency involved, we see a solid blue color even in the overlapping regions. If we were to imagine looking at this arrangement from the side, it might look something like this:

So far, I probably haven’t told you anything you didn’t already know, even if that knowledge doesn’t usually play an active role in your use of Inkscape. Indeed, for most people, the way that the shapes are ‘layered’ is purely an academic consideration: in practice, Inkscape draws solid blue pixels on the screen and you don’t need to concern yourself with the fact that they’re actually obscuring some red pixels from the rectangle behind. But there are a few situations where this knowledge is vital.

Consider screen printing – often used for printing designs onto T-shirts, posters and fabrics in general. It’s somewhat fallen out of fashion now, as on-demand printers can put your full color design onto all manner of items without the hassle of setting up your own mini print shop. But for artistic, budgetary, or other reasons, screen printing still lives on. In this process, each color in the design is printed by forcing ink through a mesh screen that carries the part of the design showing that one color alone. Repeat this with a different screen for each color, and you can reproduce complex designs, provided they only have a limited number of colors.

In the case of our design above, a naive approach would be to create one screen with a rectangle, and one with a star. First use the rectangle mesh to print in red, then align the star mesh and print the blue parts. But in this case we’re not dealing with pixels in memory that don’t exist until the final rendering step – we’re dealing with wet inks that will merge and run into each other. Our final design won’t show a blue star and red rectangle, but rather parts of each, with a muddled purple area where the shapes intersect.

What we actually want is for that overlapping area to be removed before printing. We want the design (when viewed from the side) to look more like this, with the intersection cut out of the red rectangle:

In this particular case, with just
two objects to consider, it’s not too tricky to duplicate the star and use Path > Difference to cut it out of the rectangle. But how about when three or four objects overlap – let alone more.

What is needed is a simple way to modify the image so that the final result consists only of the visible parts of paths, with no overlapping sections. In raster graphics programs, this is a common task for combining multiple layers into one, where it’s referred to as ‘flattening’ the layers. And so, with Inkscape 1.3, we now have Path > Flatten to achieve the same effect with paths.

Selecting all four paths in this example and applying this operation results in the following four objects (moved apart, and with strokes added for clarity):

For your average screen printer, this will be fine, and represents a much faster way of achieving what would previously have been a tedious and error-prone series of Boolean operations.

The other new path operation does something similar, but breaks elements apart even further. When using Path > Fracture, you not only get the flattening effect, but the overlapping shapes are further broken apart as though some Path > Division shenanigans had also taken place. You can see how, in this example, it results in far more individual paths than the Flatten operation (again, moved apart and strokes added for clarity):

To be honest, I haven’t yet thought of a good example of where flattening and splitting paths in this way would be useful. But perhaps that says more about my lack of imagination, and this feature might be just the thing you’ve been waiting for to revolutionise your Inkscape workflow.

While we’re dealing with the Boolean operations there’s another change in 1.3 that needs to be discussed: what happens when you use Path > Object to Path with a text object. If you’re getting a sense of déjà-vu, it’s because this is a topic that has cropped up previously in this series, as the Inkscape developers seem insistent on modifying the behaviour every few releases.
Up to version 0.47, this operation simply converted the entire text content into a single complex path. This made it extremely difficult to work with the individual characters (technically, glyphs), if that was your goal. Version 0.48 changed the behaviour to create a single group consisting of one path per glyph. This made some tasks a lot easier, and if you really did want just a single path, using Path > Union rather than Object to Path would still achieve that without having to ungroup and combine separate paths. All was well, until version 1.0 broke the Path > Union trick… but the developers fixed it once more in 1.0.2 (see part 100 of this series for more details).

So, aside from a brief period after version 1.0 was released, this functionality has been pretty stable: Path > Object to Path creates a group containing one path per glyph, while Path > Union creates a single path for the entire text object. Everyone was happy, and there was definitely, absolutely, no need to upset that status quo, right?

Apparently the Inkscape developers either didn’t get the memo, or there’s a secret cabal of disruptive users who never really got over the change from v0.47, because version 1.3 brings back the bad-old days when Object to Path created a single path for the entire text, with no option to create separate paths for each character. But wait! Don’t forget last month’s column, where I looked at the Path > Split Path operation. Surely that can help. Well… maybe. Sometimes. Sort of.

To use Path > Split Path you first need a path to split. Unfortunately it won’t auto-convert a text object on your behalf, so you have to use Path > Object to Path first, and then follow it up with Path > Split Path. However, as I noted last month, as useful as the Split Path function is, it doesn’t understand that you’re working with glyphs. The dot over every ‘i’ and ‘j’ becomes a separate path object, as do accents over characters, or the dots at the bottom of question and exclamation marks. If you’re lucky you might get away with using this function directly, but more often than not, there will be additional manual work required to recombine the disconnected parts of such characters.

There’s a “solution” to this problem which should be present in the 1.3.1 release (which will probably already be out by the time you read this). This version adds a Text > Text to Glyphs menu entry, which can be used to split a text object into individual glyphs before you use Path > Object to Path on them. I’ve tried it in the 1.3.1 Release Candidate build, and it works… but it’s still adding an extra step that wasn’t necessary before. If you’re still on version 1.3, you may be able to use the Text > Split Text extension (in the Extensions menu) to achieve the same result – though my own experience with this has been extremely poor, with the split characters being badly misplaced.

Speaking of badly misplaced characters, the new Text to Glyphs function also moves your text around if you’ve adjusted the vertical position or the rotation of individual characters.

The example below shows the results of both the extension, and the new function. The text in the middle is the original: I’ve deliberately used two fonts, with one of them in different weights and styles. I’ve also manually adjusted the vertical height of some of the letters, and the rotation of others.

The line at the top is the result of using the extension. To be clear, I haven’t moved it to that location – the extension decided to place the result at the top of the page, ignoring the position of the original text object. It’s done a good job of preserving the fonts, weights and styles. But not only has it ignored the vertical adjustments and the rotation, but it also has very odd ideas about the spacing between

---

The quick brown fox jumps over the lazy dog

---

The quick brown fox jumps over the lazy dog

---

The quick brown fox jumps over the lazy dog
HOWTO - INKSCAPE

The bottom line shows the result of the Text to Glyph function. This time the split text appeared in the same location as the original, so I have moved it down. You can see that the fonts, weights and styles have been preserved, but vertical alignment and rotation have, again, been ignored. Of the two, however, it definitely gives the better result.

Let’s compare this to the behaviour of 1.2.x. In this case, the original text is at the top, and two copies have been made and moved down so you can see the result of each operation more clearly. The second line is the result of Path > Object to Path. As you can see, it looks identical to the original in both style and position. But in practice, this is now a group of individual paths, one for each glyph. The third line shows the result of Path > Union, which again preserves the style and position, but loses the color change due to having created a single complex path for the whole text.

In my opinion this change in behaviour is a massive step backwards. It totally removes some perfectly reliable functionality from 1.2, replacing it with options that are far less functional – but it doesn’t appear to offer any new capability that makes this trade-off worthwhile. If you ever play around with the alignment and rotation of individual characters in your text, the only way to create a group of paths from the carefully-placed glyphs is now to use Object to Path, then Split Path, then manually fix up any characters that are made up of multiple parts. But you’ll also lose any color changes along the way, and will have to re-apply those manually as well. It turns a single step operation into something vastly more complex.

I wonder how long it will be before I’m writing a column to describe yet another change in this behaviour…?

Mark uses Inkscape to create comics for the web (www.peppertop.com/) as well as for print. You can follow him on Twitter for more comic and Inkscape content: @PeppertopComics
The Daily Waddle

WHO FARTED?

REALY??
WIO TERMINAL PART 2

It’s hard to believe that this is the 24th MicroThisMicroThat! Time does fly when you are having fun (or just when you are old).

Back in FCM#196, I wrote my first article on the Seeed Studio. Since MicroPython has upped their versions for all the various boards they support, I thought I’d try to update my little Wio terminal and re-test the program that I had written to see if it still worked. Just so you know, this was after the above-mentioned article, and I just never had a good chance to talk about it.

Now, just a little background on writing to the Wio screen. It isn’t as easy as the normal screen output for, let’s say, a ssd1306.

Remember, drivers try to be fairly generic in nature, while still being able to take as much advantage of the abilities of the display as possible. The driver for the ili9341 is no exception. As you saw in my article in FCM #196, this driver not only handles lines, circles, single pixels, and blocks, it also handles text. It even handles many font definitions for different text output to the screen.

Start by updating your Micropython firmware to version v1.21.0. You can download it at https://micropython.org/download/SEED_WIO_TERMINAL/

Next, make sure you have the latest version of the LCD driver. This you can get from https://github.com/rdagger/micropython-ili9341/blob/master/ili9341.py

For this article, we’ll focus on demonstrating the 8x8 default Micropython font. We’ll look at using different fonts in a later article.

We’ll name this program “demo_text8x8.py”.

Of course, we need to do the imports (top right)...

Now we must define the backlight pin (below) and the spi object. After that, we can initialize the display object. Notice, if you are going to use the demo programs from the ili9341 driver website, you will need to change the spi assignments as I’ve done here. Also notice that we start the display with a default rotation of 90. This puts the display in (what I consider) the correct orientation, which is with the USB Cable at the bottom of the Wio terminal. We will send other rotation orientations near the end of the demo.

```python
def test():
    """Test code."""
    #spi = SPI(1, baudrate=40000000, sck=Pin(14), mosi=Pin(13))
    #display = Display(spi, dc=Pin(4), cs=Pin(16), rst=Pin(17))
    backlight = Pin("LED_LCD", Pin.OUT)  # backlight is not a PWM pin
    spi = SPI(7, sck=Pin("LCD_SCK"), mosi=Pin("LCD_MOSI"), miso=Pin("LCD_MISO"), baudrate=4000000)
    display = Display(spi, dc=Pin("LCD_D_C"), cs=Pin("LCD_CS"),
                     rst=Pin("LCD_RESET"), width=320, height=240, rotation=90)
```
Now we can start sending text to the display through the `display.draw_text8x8()` method of the display driver (right).

Finally, we set the time that the display will be on, call the `cleanup()` method of the display, and turn off the backlight. The last thing we do is call the `test()` function.

```python
sleep(15)
display.cleanup()
backlight.off()
test()
```

That’s it.

I’ve set up another repository at my github repository site [https://github.com/gregwa1953/MTMT-FCM-199](https://github.com/gregwa1953/MTMT-FCM-199).

Until next time, as always; stay safe, healthy, positive and creative!

---

x_center = display.width // 2
y_center = display.height // 2

# ---------------------------------------
# GDW Added 12 November, 2023
bkgnd = 0x039F  # Brandeis Blue
display.display_on()
display.clear(bkgnd)
backlight.on()

---

Greg Walters is a retired programmer living in Central Texas, USA. He has been a programmer since 1972 and in his spare time, he is an author, amateur photographer, luthier, fair musician and a pretty darn good cook. He still is the owner of RainyDaySolutions a consulting company and he spends most of his time writing articles for FCM and tutorials. His website is [www.thedesignatedgeek.xyz](http://www.thedesignatedgeek.xyz).
Linux on Your iPad

For as low as $4.95, you can have your own personal Linux cloud computer in minutes on any device.

GET IT ON
macOS

Get it on
Windows 10

Download for
Linux

Download on the
App Store

GET IT ON
Google Play
UBPORTS DEVICES
Written by UBports Team
I CAN HAZ PENGUIN?
Clear and concise guides to help you learn with minimal time and effort!

Order direct from ineasysteps.com and get 25% discount!
Enter FC25 in the Coupon Code box at the checkout.
Everything on Ubuntu is my favorite, including snaps. I don’t have any issues with them. The Unity desktop was nice too, until things went downhill with the Amazon integration. In this article, I am going to discuss my three favourite application software on Linux. I use these applications daily, and I would say there are no easy alternatives available on other operating systems.

**gThumb: An Image Viewer With a Sleek UI**

Gnome developers maintain gThumb and it is available free of cost for most of the distributions. It is easy to install gThumb on Ubuntu and related .deb-based distributions like Linux Mint.

In a terminal, enter:

```
sudo apt install gthumb
```

And voila, there you are.

Here is what gThumbs looks like on my computer. I drew that drawing myself on an iPad back in 2012.

You can see I divided the image into three blocks. The first block helps me to make changes in an image file. For instance, I can change the aspect ratio and size of an image by choosing the options in the format category available at the end of the block.

I can add filters and adjust colors using options available in the color category. It is as simple as two clicks as shown in the following image.

Block two helps me to rotate and zoom the images. In block three, you can see the aspect ratio, size, and zoom level all in one place. All these simple tasks are a bit difficult in other image manipulation software like GIMP which are targeted toward professional photographers.
MY STORY

gThumb also helps me to convert image formats including the modern ones like WebP and AVIF. It has a really nice understanding of compression levels while converting the images. I am very happy with all of these features.

Now let us hop to the next application.

THE REDNOTEBOOK

Here comes The RedNotebook, an excellent offline diary! This application software is an integral part of my daily digital life. It has helped me to achieve goals, track, and change my habits. RedNotebook is very dear to me, and I am really grateful to the developer for keeping it free of cost.

Jendrik Seipp from Sweden develops the software in Python. He has made it available for all the operating systems in the world. On Ubuntu, RedNotebook is as simple to use as using a text editor. The text editors just do not have the gut to work as a journal though.

You can find it in the Ubuntu Software catalogue or as always choose the geeky way to install it. In a terminal, run:

```sh
sudo apt install rednotebook
```

Once installed, the developer will hook you to clean aesthetics of the user interface as shown below.

RedNotebook supports markdown but it is completely okay if I do not choose to write in markdown. The software focuses on journaling and gives priority to formatting the text. Again in markdown only. A user can export their journals in HTML and then open that HTML in the browser to print to a PDF file. This works perfectly for me. I never exported to Latex and I really do not want to at this time. One of my professors asked me to write the undergraduate thesis in Latex and I almost gave up on the thesis altogether.

Here is the export screen and you can see the developer kept the process simple. It cannot be simpler than this.

Besides RedNotebook, I only use my website for drafting, but in the
last two years, my drafts have been sitting on a server to lay some eggs. I might publish all the drafts at once after publishing this article in FCM.

Now, my dear reader, I want to share the last software that helps me daily while using Ubuntu.

HTOP

I would say without Htop I would have never been able to overcome certain Linux issues. Htop is one of the best process-viewers available for Linux users. Most of the time, only system admins use it, but if a normal computer user like me puts some efforts working with the Htop, then the sky is the limit for the possibilities and swiftness of finishing a task. You can truly finish a task using Htop.

Hisham Muhammad developed Htop using the C language. He also maintained it for fifteen years. Htop is the most prominent application in Linux systems. I am currently using v3.2.2 on Ubuntu 23.04.

It is simple to install Htop on Ubuntu. In a terminal, enter:

```
sudo apt install htop
```

As seen in the image (taken from the Htop website) this system monitor gives me a clear insight into all the processes running at once. You can see how many tasks are running, how much memory is used, and which applications are consuming more or less resources.

I do not need to touch the mouse while working with Htop. It’s all set up with function keys and a few custom bindings of my own.

CONCLUSION

If you have not used any of these software, I would implore you to try them today. If you are a GIMP user, but you only resize the images or change the formats, then give gThumb a try. I would say you won’t regret it.

For journaling, I would recommend trying RedNotebook once at least. You can create notes and to-do lists for work, and then export them the way you want.

I’ll return next month together with a new and amazing and more technical article. Until then take care of yourself and everybody around you.
<table>
<thead>
<tr>
<th>Title</th>
<th>Edition</th>
<th>ISBN</th>
<th>Format</th>
<th>Price</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Python Crash Course, 3rd Edition</td>
<td></td>
<td>9781718502703</td>
<td>PB</td>
<td>$44.99</td>
<td>552</td>
</tr>
<tr>
<td>The Recursive Book of Recursion</td>
<td></td>
<td>9781718502024</td>
<td>PB</td>
<td>$33.99</td>
<td>328</td>
</tr>
<tr>
<td>Dead Simple Python</td>
<td></td>
<td>9781718500921</td>
<td>PB</td>
<td>$59.99</td>
<td>752</td>
</tr>
<tr>
<td>How Linux Works, 3rd Edition</td>
<td></td>
<td>9781718500402</td>
<td>PB</td>
<td>$49.99</td>
<td>464</td>
</tr>
<tr>
<td>Practical Linux Forensics</td>
<td></td>
<td>9781718501966</td>
<td>PB</td>
<td>$59.99</td>
<td>400</td>
</tr>
<tr>
<td>DevOps for the Desperate</td>
<td></td>
<td>9781718502482</td>
<td>PB</td>
<td>$29.99</td>
<td>176</td>
</tr>
<tr>
<td>The Rust Programming Language, 2nd Edition</td>
<td></td>
<td>9781718503106</td>
<td>PB</td>
<td>$49.99</td>
<td>560</td>
</tr>
<tr>
<td>Data Structures the Fun Way</td>
<td></td>
<td>9781718502604</td>
<td>PB</td>
<td>$39.99</td>
<td>304</td>
</tr>
<tr>
<td>Deep Learning</td>
<td></td>
<td>9781718500723</td>
<td>PB</td>
<td>$99.99</td>
<td>776</td>
</tr>
<tr>
<td>Codebreaking</td>
<td></td>
<td>9781718502727</td>
<td>PB</td>
<td>$29.99</td>
<td>488</td>
</tr>
</tbody>
</table>

Get 25% off your order at nostarch.com with code FULLCIRCLE25
GUIDELINES

The single rule for an article is that it must somehow be linked to Ubuntu or one of the many derivatives of Ubuntu (Kubuntu, Xubuntu, Lubuntu, etc).

RULES

• There is no word limit for articles, but be advised that long articles may be split across several issues.

• For advice, please refer to the Official Full Circle Style Guide: http://bit.ly/fcmwriting

• Write your article in whichever software you choose, I would recommend LibreOffice, but most importantly - PLEASE SPELL AND GRAMMAR CHECK IT!

• In your article, please indicate where you would like a particular image to be placed by indicating the image name in a new paragraph or by embedding the image in the ODT (Open Office) document.

• Images should be JPG, no wider than 800 pixels, and use low compression.

• Do not use tables or any type of bold or italic formatting.

If you are writing a review, please follow these guidelines:

When you are ready to submit your article please email it to: articles@fullcirclemagazine.org

TRANSITIONS

If you would like to translate Full Circle into your native language please send an email to ronnie@fullcirclemagazine.org and we will either put you in touch with an existing team, or give you access to the raw text to translate from. With a completed PDF, you will be able to upload your file to the main Full Circle site.

REVIEWS

GAMES/APPLICATIONS
When reviewing games/applications please state clearly:

• title of the game
• who makes the game
• is it free, or a paid download?
• where to get it from (give download/homepage URL)
• is it Linux native, or did you use Wine?
• your marks out of five
• a summary with positive and negative points

HARDWARE
When reviewing hardware please state clearly:

• make and model of the hardware
• what category would you put this hardware into?
• any glitches that you may have had while using the hardware?
• easy to get the hardware working in Linux?
• did you have to use Windows drivers?
• marks out of five
• a summary with positive and negative points

You don't need to be an expert to write an article - write about the games, applications and hardware that you use every day.
It is always an interesting period of time when we get near the end of the Ubuntu release cycle to see if things go quietly into the night or if there is a fury of last-minute activity. Ubuntu 23.10 comes at such a point, and, in this release cycle, the answer is more fury than quietude.

This final interim release (in this cycle) came out on 12 October, 2023, and brings a surprising volume of new things, although most of them are small changes. Overall, Ubuntu 23.10 is the 39th release for Ubuntu, and the 13th with the modified Gnome desktop, so it is probably fair to claim that Ubuntu is a pretty mature distribution these days. It comes with nine months of support, until July, 2024. The next Ubuntu release will be the long-term-support version that completes this cycle, 24.04 LTS, due out in April, 2024.

Even though Ubuntu 23.10 was out on time, it was not available for long. I was lucky to get a download via BitTorrent right away, as within three hours the desktop version had been pulled due to the post-release discovery of a malicious translation of a political nature in the Ukrainian language installer. It was posted again for download four days later, on 16 October, 2023, as a new version, Ubuntu 23.10.1. It sounds like at least one Ubuntu translation contributor will get the boot.

Given the code name “Mantic Minotaur”, Ubuntu 23.10 is not the first release to bear the name of a mythical animal. It follows Ubuntu 9.04 “Jaunty Jackalope”, Ubuntu 14.10 “Utopic Unicorn” and Ubuntu 15.10 “Wily Werewolf”. In case anyone asks, the term “mantic” means having the power of divination or prophesy. The Minotaur of Greek mythology was the half man-half bull that lived in the labyrinth on Crete that was designed by the architect Daedalus and his son Icarus, of aviation misadventure fame. After eating a lot of people, the Minotaur was killed by the Athenian hero Theseus.

Because the Ubuntu project is now working its way through the alphabet for the second time, 13 years apart, this is the second “M” coded release, following Ubuntu 10.10 “Maverick Meerkat”, which was released on 10 October, 2010.

**INSTALLATION**

I downloaded the release from the official source via BitTorrent, which probably allowed me to get a copy on release day. It was quickly removed and was no longer available from the normal downloads, although BitTorrent kept working once running. I did an SHA256 sum check to make sure the download was not corrupted, which is always a good idea. I tested Ubuntu 23.10 from a USB stick equipped with Ventoy 1.0.96 and it booted perfectly.

The download for Ubuntu 23.10 was 5.2 GB, which is 6% bigger than the last release, Ubuntu 23.04, which was 4.9 GB. Ubuntu 23.10 is now almost double the size of the release from two years ago, Ubuntu 21.10, which was 2.9 GB.

There is a story here, but not one with a truly happy ending. For a
number of releases now, Ubuntu’s installer has offered an optional “minimal” installation, which included just the basic desktop, Firefox web browser, Gnome Text Editor, and Gnome Terminal, plus the graphical Snap Store to install any additional software desired. I actually like that approach, as it allows just installing the applications you need and not having to remove a bunch of clutter you don’t want. To cut down the size of the ISO file download, the developers wanted to make the minimal installation the new default and sole installation option. That proposal resulted in some heated debate, with some people arguing that Ubuntu’s greatest strength is its ready-to-use, out-of-the-box configuration, making it easy for beginners to jump right in. In the end, a compromise was reached that the minimal installation would become the new default, but the installer would also clearly offer a “full installation” option, and that it would be within the downloaded ISO file – not just from the internet. That means that all the applications lacking in the minimal installation, such as LibreOffice and Thunderbird, are all still there in the ISO file, just not used – unless a full installation is chosen. The big advantage of a minimal installation is that it results in a small ISO download size but this compromise means you get a huge file to download and then a default minimal installation – probably the worst of both worlds.

It is worth noting that, when booting up the ISO to a live session, you get the “full installation” experience and not the minimal (default) desktop.

**SYSTEM REQUIREMENTS**

The recommended minimum system requirements for Ubuntu 23.10 have not changed since 20.04 LTS and remain:
- 2 GHz dual-core processor
- 4 GB RAM
- 25 GB of hard-drive, USB stick, memory card, or external drive space
- Screen capable of 1024x768 pixel screen resolution
- Either a CD/DVD drive or a USB port for the installation media
- Internet access is useful, but not essential

This means that Ubuntu 23.10 should run fine on hardware designed for Windows 7 or later, although I would suggest at least 8 GB of RAM is needed as a working minimum.

**NEW**

As noted, this release introduces a large number of mostly small changes, in time to get them in before the next LTS release. A few are changes that desktop users will
notice, and the rest are more “behind-the-scenes”.

The changes that desktop users will notice include the use of the Gnome 45.0 desktop, including associated updated applications; a newly rewritten, Flutter-based, App Center which replaces the old Snap Store; a new standalone Firmware Updater application; the Gnome Clocks application, which is included by default with its world clocks, stopwatch and timers; a new workspace indicator in the top-left of the screen which replaces the previous "activities" menu, and expanded window tiling capabilities, including quarter and half screen tiling.

The more "behind the scenes" changes that regular desktop users will probably not notice so much include “preview support” for hardware backed full-disk encryption with the encryption keys stored in the Trusted Platform Module (TPM) and recovered automatically by authenticated boot software; support for Raspberry Pi 5 and SiFive HiFive Pro P550; Netplan 0.107 networking configuration tool included, Docker 24.0.5 with Docker plugins, docker-buildx and docker-compose-v2; support for ZFS guided installations; updated Ubuntu fonts, and many security improvements including requiring programs to have AppArmor profiles.

Furthermore, many toolkits and other background packages have been updated: Mesa 23.2 graphics drivers; GCC 13.2.0; binutils 2.41; glibc 2.38; Python 3.11.6 with 3.12.0 is available in the archive; Perl 5.36.0; LLVM 16 with 17 is available in the archive; Rust 1.71; OpenJDK 17 is provided with OpenJDK 21 available but not used for package builds; .NET 7 packages were updated to 7.0.110, and .NET 6 packages were updated to 6.0.121; Go 1.21; BlueZ 5.68; Cairo 1.18; NetworkManager 1.44; Pipewire 0.3.79 audio; Poppler 23.08 and xdg-desktop-portal version 1.18. This should add up to better Bluetooth headphone and trackpad support.

This release includes Linux kernel 6.5, while the init system is systemd 253.5.

When combined with the changes introduced earlier in the development cycle, this is going to add up to quite a bit – heading into the upcoming LTS release.

**SETTINGS**

Predictably, there are new Minotaur-themed wallpapers provided for this release. In fact, of the 14 wallpapers provided, ten of them have Minotaurs on them. One is even an 8-bit Minotaur rendition that looks like it escaped from Super Mario.
REVIEW

Otherwise, Ubuntu 23.10 continues to offer just two window themes: standard (light) and dark. With the default wallpaper in use, switching to the dark window theme also switches that wallpaper to a dark version. Overall, that makes the display so dark it is hard to discern the windows in use. A lighter wallpaper actually works better with the dark window theme.

APPLICATIONS

Some of the applications included with Ubuntu 23.10 full installation are:
- Archive Manager (file-roller) 43.0 archiver*
- Cheese 44.1 webcam application
- CUPS 2.4.6 printing system
- Document Viewer (evince) 45.0 PDF viewer
- Document Scanner (simple-scan) 44.0 optical scanner*
- Duplicity 1.2.2 file back-ups
- Files (nautilus) 45 RC file manager
- Firefox 118.0.1 web browser**
- Gnome Calendar 45.0 desktop calendar
- Gnome Clocks 45.0 clocks
- Gnome Disks 45.0 disk manager
- Gnome Terminal 3.49.92 terminal emulator
- Gnome Text Editor 45.0 text editor
- Gparted 1.5.0 partition editor***
- Image Viewer (Eye of Gnome) 45.0 image viewer
- LibreOffice 7.6.2 office suite
- PipeWire 0.3.79 audio controller
- Remmina 1.4.31 remote desktop client
- Rhythmbox 3.4.7 music player
- Shotwell 0.32.2 photo manager
- Startup Disk Creator 0.3.17 (usb-creator-gtk) USB ISO writer
- Systemd 253.5 init system
- Thunderbird 115.3.1 email client
- Transmission 4.0.2 bittorrent client
- Ubuntu App Center 1.0.0 alpha package management system**
- Videos (totem) 43.0 movie player*
- Wget 1.21.3 command-line webpage downloader*

* indicates same application version as used in Ubuntu 23.04
** supplied as a snap so version depends on the upstream package manager
*** indicates included on the ISO for boot-up but not included in a full installation. May be installed from the repositories.

The application collection represents a mix of Gnome versions, but mostly from Gnome 45 with a few holdovers from Gnome 43 and 44. The addition of Gnome Clocks and the rewritten App Center replacing the old Snap Store are the only changes to the provided suite of applications.

The App Center actually is a worthwhile update. This is a rewrite of the Snap Store using the Flutter toolkit, but it works better. It is not only faster and lighter but, best of all, it now allows installing both
REVIEW

Snap and Deb files which are the two preferred package formats on Ubuntu these days.

The Files (Nautilus) file manager, version 45 RC, has improved performance – loading and displaying files more quickly and generating faster thumbnails.

The Firefox web browser is still a Snap package but now works in Wayland mode by default instead of Xwayland. This means that web page rendering is much more clear and sharp, plus it includes full touchscreen support.

CONCLUSIONS

Ubuntu 23.10 brings a surprisingly large number of last minute changes to this development cycle. This means the next long-term-support version, Ubuntu 24.04 LTS, will be significantly different from the last LTS, 22.04. Ubuntu 24.04 LTS is expected out in April, 2024.

EXTERNAL LINKS

Official website: https://ubuntu.com/

Adam Hunt started using Ubuntu in 2007 and has used Lubuntu since 2010. He lives in Ottawa, Ontario, Canada, in a house with no Windows.
MiniOS is both a new and an old Linux distribution. It is kind of a “retread”.

It was originally started in 2009, as a lightweight distribution, intended to be run from a USB stick, and based on Mandriva. It lasted as long as Mandriva, and when that project ended in 2013, so did MiniOS after being available for only four years. Seven years later, in 2020, it was resurrected, but based on Debian instead.

There is not a lot of information about MiniOS as it does not have a DistroWatch page, and there have been few reviews. Its aim is to be a “lightweight and fast distribution” that can be installed conventionally on a hard drive or run from a USB stick. That aim begs comparisons with other lightweight distributions also designed to be run from sticks, like Puppy Linux and SliTaz.

The MiniOS project seems to be run by just one anonymous developer. This is not necessarily a bad thing in and of itself as several distributions are run by only one person but it does mean that if they get busy, lose interest, or die, then the distribution may not survive. Just something to keep in mind. With bigger developer communities, there is usually someone with the commitment, experience and enthusiasm to take over and keep things running.

**BACKGROUND**

As of 2023, MiniOS comes in six different editions:
- **Flux** - a very lightweight version using Fluxbox, only minimal software, and no browser, 32- and 64-bit versions available, around 355 MB to download.
- **Minimum** - based on an older version of Debian with the Xfce desktop and minimal software included, 32- and 64-bit, around 375 MB.
- **Standard** - a few more features and the current version of Debian, Xfce desktop, 32- and 64-bit, around 560 MB.
- **Maximum** - a more complete desktop including office and media player software, 64-bit only, around 695 MB.
- **Ultra** - including virtualization and 3D modeling software, 64-bit only, around 1370 MB.
Puzzle - a system builder version that offers modular additions, 64-bit only, 530 MB or 1660 MB.

One of the main factors that marks MiniOS as different, is its use of system configuration modules. These text files, used on boot-up, allow easy customization, which is very useful when booting from a USB. These can be saved for "persistence", meaning they will automatically load on restart, and may be edited by hand.

As a project, MiniOS is lacking some things normally found in Linux distributions, including BitTorrent downloads, minimum system specifications, and any sort of checksums to ensure that your download is uncorrupted.

**GETTING MINIOS**

All downloads are from the official website via https. I decided to try out the Minimal and Standard editions and so downloaded both.

The Minimal version is MiniOS Buster Xfce Minimum AMD 64 20230815_1045, and it was 373 MB to download. This release dates from 15 August, 2023, but is based on Debian 10.0 Buster, which was released on 6 July, 2019, making it four years old and two versions behind current.

MiniOS Bookworm XFCE Standard AMD 64 20230815_1122 was 596 MB to download. This release also dates from 15 August, 2023, and is based on Debian 12.0 Bookworm, released on 10 June, 2023, which is the current version of Debian.

**INSTALLING**

I tested both by dropping the ISO files onto a USB stick equipped with Ventoy 1.0.95 and booted them up from there. No version of MiniOS is listed by Ventoy as having been tested and supported, but the MiniOS website says they will work on Ventoy and they do. Being based on Debian, it is not totally surprising that it works. MiniOS can also be booted using Rufus, Unetbootin, and BalenaEtcher, among other applications.

MiniOS can be booted in a UEFI or a traditional BIOS environment.

Each version comes with its own installer for hard drives or USB sticks, and offers a choice of file systems at installation including btrfs, ext 2, 3 or 4, fat32 and ntfs. I am not sure I have ever seen a Linux system running on those last two file systems! If you aren’t sure, then ext4 is a safe bet.

**TRYING OUT MINIOS**

I started with a look at MiniOS...
Minimal. It boots up to a nice Xfce desktop with the classic simple menu. Indeed the whole thing is quite minimal and does not come with much at all. One of the things it does really lack is any sort of graphical software management to run updates or add applications. APT works fine from the command-line, and, once you run updates and upgrades, then the whole normal Debian repositories are available for use. Because this is based on Debian Buster, though, this means the repositories are similarly old and have old application versions.

The user case for having a current release based on four-year-old Debian 10.0 is not clearly explained in the rather “minimalist” MiniOS documentation, but perhaps it is to keep file sizes smaller. Regardless, here in 2023, it works but is not really a great choice.

I next gave MiniOS Standard a try. The website claims this version is “the most balanced version of the system, which combines compactness and necessary functionality along with a user-friendly interface.” It certainly does come with a few more features. Being based on the current Debian version, it has access to the current Debian repositories which include the newer application versions. All of that adds up to a better release.

Both versions have normal Xfce settings menus, making customizing a familiar task for anyone who has used this desktop before.

The Minimal version comes with just two identical green MiniOS wallpapers, one with the logo and the other without. It has four icon sets: elementary Xfce, dark, darker, and darkest, with dark as the default. They are all fine, look good, and do give a bit of customization.

Both versions have normal Xfce settings menus, making customizing a familiar task for anyone who has used this desktop before.

The Standard version comes with 39 wallpapers, all of them MiniOS themed, but at least you get a variety of colors! You can always use your own wallpaper, too. There are still just two window themes provided, in this case Greybird and Greybird-dark.

### Applications

MiniOS Minimal includes the old Xfce 4.12 desktop from Debian Buster. The applications included are:
- Firefox 102.14.0 ESR - web browser
- Htop 2.2.0 - system monitor
- Mousepad 0.4.1 - text editor
- Ristretto 0.8.3 - image viewer
- Thunar 1.8.4 - file browser
- Thunar Bulk rename 1.8.4 - file renamer
- Xarchiver 0.5.4.14 - file archiver
- Xterm 344-1 - terminal emulator

and that is pretty much it, living up to its name! As can be seen, it is lacking a lot of applications typically found in most distributions such as an email client, office suite, audio and video player, or even a PDF reader! Also missing is something we software reviewers need, the Xfce screenshot tool, xfce-screenshooter.

Probably most notably, there is
no graphical software management application to run updates or install any applications. Because MiniOS is based on Debian, APT works fine for these tasks from the command-line. After running updates and upgrades, the whole Debian repository is there to install any desired applications. I added Synaptic as a simple graphical package manager, and Evince for PDFs. Even though they are old versions, the Buster repositories have such programs as LibreOffice, GIMP, and Chromium. They also have xfce-screenshooter available and so I was able to get some screenshots for this review, too.

MiniOS Standard adds some elements to the bare basics found in Minimal including the more modern Xfce 4.18 desktop. It doesn’t add many additional applications though, only: xfce4-screenshooter 1.10.3 - screenshot tool Remmina 1.4.2.9 - remote desktop client

The inclusion of the screenshot tool in MiniOS Standard by default was appreciated, but there is still no graphical software management. As with Minimal, by running updates and upgrades from the command-line with APT, I was able to install Synaptic and any other needed applications. Of course, if you are like me and enjoy using APT from the command-line, then you will find MiniOS already has everything it needs to get started.

Because both these versions require command-line skills, neither are really suitable for Linux beginners. The skimpy documentation provided on the official website is not much help either. There is a Telegram channel and the GitHub forum for support, but they seem rarely used. Because MiniOS is based on Debian, the parent distribution’s much more extensive documentation may be of more help.

**Comparisons**

It is tempting to compare MiniOS in its Minimal and Standard versions to other small live USB-oriented distributions such as Puppy Linux and SliTaz, but those two distributions are generally lighter, more complete and ready to use, not to mention more Linux beginner-friendly.

In many ways, MiniOS is comparable to SpirialLinux, both being distributions that really package Debian in ways that make it more ready to use out-of-the-box, at least for experienced Linux users.

**Conclusions**

MiniOS Minimal and Standard both provide nice, simple Xfce desktops. They both work well and, even though they come with very little in the way of application software, can be customized with anything needed from the Debian repositories.

Unless you have a very specific reason to be using a version of Debian that is old and out of date, I would recommend just downloading Standard and skipping Minimal.

Due to its reliance on command-line use and minimal documentation, this is not really a distribution for Linux beginners, but may appeal to users with some experience who are looking for something light and fast.

**External Links**

If you would like to submit a letter for publication, compliment or complaint, please email it to: letters@fullcirclemagazine.org. PLEASE NOTE: some letters may be edited for space.

Letters

If you would like to submit a letter for publication, compliment or complaint, please email it to: letters@fullcirclemagazine.org. PLEASE NOTE: some letters may be edited for space.

Join us on:

Facebook.com/fullcirclemagazine
twitter.com/#!/fullcirclemag
linkedin.com/company/full-circle-magazine
ubuntuforums.org/forumdisplay.php?f=270

FULL CIRCLE NEEDS YOU!

Without reader input Full Circle would be an empty PDF file (which I don't think many people would find particularly interesting). We are always looking for articles, reviews, anything! Even small things like letters and desktop screens help fill the magazine.

See the article Writing for Full Circle in this issue to read our basic guidelines.

Have a look at the last page of any issue to get the details of where to send your contributions.
Welcome back to another edition of Questions and Answers! In this section we will endeavour to answer your Ubuntu questions. Be sure to add details of the version of your operating system and your hardware. I will try to remove any personally identifiable strings from questions, but it is best not to include things like serial numbers, UUIDs, or IP addresses. If your question does not appear immediately, it is just because there is such a lot, and I do them, first-come-first-served.

There was this employee once, working for the same company I did, who was terminated. A month, maybe two, before termination, I went to his station to check on him and noticed his machine was exceptionally grimey. I offered to clean it for him and had to wash the cloth afterwards as it just made streaks after a while of cleaning, and went from blue to grey. (Yes it was that dirty.) After his termination, I had to farm the laptop out to the next guy to take his place. I flipped the laptop open and found it was in the same state it was a few months earlier. There was fat caked around the keys. When I say this I mean the amount of hard lard seemed to just fit inside the holes when you depress a key. As disgusting as it was, I needed to clean it out as I could not give it like that to the next guy. Once I was done scraping off the lard, I realised that the keyboard seemed crunchy. I flipped it over and gently patted it on the back. Something I regretted as my desk became a beach. I had to repeat this action over and over and over until the amount of sand coming out was minimal. I have no idea what happened or if the guy just worked from the beach, but please never, ever use lard or schmaltz to lube your keyboard as there is too much sand in it. Especially when the laptop belongs to someone else.

I have a Dell 9520 and my wife has my old Dell 9510 – She has an i7 and I have an i9. Otherwise the machines are basically identical. We were running Ubuntu 20.04, but decided to take the plunge and install 22.04.3. That’s when the problems started. We cannot shut down or restart without holding down the power button. Sleep does not function. We have followed all the advice on the internet we could find, but it made no difference. We do not run any proprietary software or anything *not* from the app store. One thing I did notice is that the drivers section is empty, even though we both have Nvidia 3050 for sure, it should at least offer us the option?

That is a manufacturer setting in your laptop’s BIOS / UEFI – there are magnets in the screen and base that flip the internal switch, it is not Ubuntu related.

I have app images that are supposed to be all self contained. They work 100% on Xubuntu 20.04, but do not work on Gnome Ubuntu 22.04. How can this be – if the so-called self contained application contains everything it needs to work? These are applications I cannot get any more as I need a specific version, so the snap is not going to work for me.

As to how self contained App Images are, I cannot comment, but the issue may be that you are in a Wayland session now by default? You can always load up a virtual machine with Xubuntu 20.04 for
just that application, if it is so important. VirtualBox has the option to share a folder between the host and the guest OS, if you need to save your work to the host.

Q: I was looking on Distrowatch.com at the Ubuntu release for 22.04 and I noticed that there was no Ubuntu Cinnamon listed in the releases. As a Mint user, I am very interested in this as Mint is always slightly behind Ubuntu. I checked the Ubuntu Cinnamon page and it definitely had 22.04, so is it just for testing purposes? Ideally I want to try 23.04.

A: As far as I know, it is not yet, but according to their website, it is: "Ubuntu Cinnamon is a community-driven flavor of Ubuntu"

Q: This may sound silly, but I don’t know what to search for on google as I get mixed results. I am downloading a distro from distrowatch via torrent. On the page, next to the torrent, there is a sha256-> (2,528MB, SHA256, torrent). I can download it, but I don’t know how to check it. It says I must do -> sha256sum -c SHA256SUMS ? Maybe my head is too flat for Ubuntu?

A: Simplest I can make it, type: sha256sum ubuntu-22.04.3-live-server-amd64.iso (Insert your .iso name, don’t use mine) and press enter. It will take a few seconds to compute. I copy-paste both the computed number and the sha256 from the web into a text editor underneath each other and my eye is fast enough to compare.

Q: I am new, been running Ubuntu for a year now. I understand that ctrl-c is copy, but in the terminal it is break, but why does ctrl-v for paste not work as intended?

A: Consistency. (That is the simple answer. Use the shift key). CTRL+SHIFT+C and CTRL+SHIFT+V when you work with the terminal. It will become second nature soon.

Q: Should I upgrade to 23.04 or wait for 24.04 ?

A: I’d say wait, there are a few things *not working in 23.04 (like virtualbox) that will be ironed out when the LTS arrives.

Q: I have an Acer Aspire R13 that I want to rescue. However, after installing Ubuntu, there is no boot device. I have checked the downloaded ISO and verified it. I have tried both Ubuntu 22.04 and 23.04, and for kicks Manjaro. What does this mean?

A: There is just the fix for you: https://itsfoss.com/no-bootable-device-found-ubuntu/

Q: I installed the Nvidia drivers on my XPS laptop, and ever since doing that, my fans have been running full taps. I have tried some of the solutions like TLP and power saving mode. Nothing seems to work. I mean it keeps my machine nice and cool, but it is not great when I need it to be silent.

A: If you really have tried everything, the XPS range has a setting in the BIOS / UEFI (Happy now Pence?) that allows you to set the fan to full blast, silent, optimised, etc. Please set your fan as each of these and reboot before finally setting it to silent. I think it is a bug in the firmware. By the time you read this it may already be fixed.
### PATRONS

#### MONTHLY PATRONS

- Alex Crabtree
- Alex Popescu
- Andy Garay
- Bill Berninghausen
- Bob C
- Brian Bogdan
- CBinMV
- Darren
- Dennis Mack
- Devin McPherson
- Doug Bruce
- Elizabeth K. Joseph
- Eric Meddleton
- Gary Campbell
- George Smith
- Henry D Mills
- Hugo Sutherland
- Jack
- Jack Hamm
- Jason D. Moss
- Joao Cantinho Lopes
- John Andrews
- John Malon
- John Prigge
- Jonathan Pienaar
- Joseph Gulizia
- JT
- Katrina
- Kevin O’Brien
- Lee Allen
- Lee Layland
- Leo Paesen
- Linda P
- Mark Shuttleworth
- Moss Bliss
- Norman Phillips
- Oscar Rivera
- Paul Anderson
- Paul Readovin
- Rino Ragucci
- Rob Fitzgerald
- Robin Woodburn
- Roy Milner
- Scott Mack
- Sony Varghese
- Taylor Conroy
- Tom Bell
- Tony
- Vincent Jobard
- Volker Bradley
- William von Hagen

#### SINGLE DONATIONS

**2023:**
- Floyd Smith
- Richard Almeida
- Gavin Thompson
- Raymond Mccarthy
- Michael Grugel
- Linda Prinsen
- Thomas A Lawell
- Ronald Le Blanc
- Ronald Eike
- Kenneth Martin
- Lance Jacob
- Roberto Machorro Mejia
- Paul Radovan
- Christopher LaSota

The current site was created thanks to **Arun** (from our Telegram channel) who took on the task of completely rebuilding the site, from scratch, in his own time.

The Patreon page is to help pay the domain and hosting fees. The money also helps with the new mailing list.

Several people have asked for a PayPal (single donation) option, so I’ve added a button below.

**A big thank you to all those who’ve used Patreon and the PayPal button. It’s a HUGE help.**

[https://www.patreon.com/fullcirclemagazine](https://www.patreon.com/fullcirclemagazine)

[https://paypal.me/ronnietucker](https://paypal.me/ronnietucker)

[https://donorbox.org/recurring-monthly-donation](https://donorbox.org/recurring-monthly-donation)
FULL CIRCLE NEEDS YOU!
A magazine isn’t a magazine without articles and Full Circle is no exception. We need your opinions, desktops, stories, how-to’s, reviews, and anything else you want to tell your fellow *buntu users. Send your articles to: articles@fullcirclemagazine.org

We are always looking for new articles to include in Full Circle. For help and advice please see the Official Full Circle Style Guide: http://bit.ly/fcmwriting

Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our site via: fullcirclemagazine.org

FCM#200
Deadline: Sunday 10th Dec 2023.
Release: Friday 29th Dec 2023.

Getting Full Circle Magazine:
EPUB Format - Most editions have a link to the epub file on that issue's download page. If you have any problems with the epub file, email: mobile@fullcirclemagazine.org
Issuu - From Feb. 2023 Issuu are removing all free items with 50+ pages. So most (if not all) issues of FCM will vanish.

For the Full Circle Weekly News:
You can keep up to date with the Weekly News using the RSS feed: http://fullcirclemagazine.org/feed/podcast
Or, if you’re out and about, you can get the Weekly News via Stitcher Radio (Android/iOS/web): http://www.stitcher.com/s?fid=85347&refid=stpr
and via TuneIn at: http://tunein.com/radio/Full-Circle-Weekly-News-p855064/

FCM PATREON: https://www.patreon.com/fullcirclemagazine